
Time Allowed: 2 hours Maximum Marks: 50
General Instructions:

1. This Question Paper has 5 Sections A-E.
2. All Questions are compulsory. However, internal choices have been provided in

some of the questions.
3. Section A has 12 questions carrying 01 mark each.
4. Section B has 7 Short Answer (SA-I) type questions carrying 02 marks each.
5. Section C has 4 Short Answer (SA-II) type questions carrying 03 marks each.
6. Section D has 1 Long Answer (LA) type question carrying 04 marks.
7. Section E has 2 Source based /Case-based /Passage based Questions carrying 04

marks each.

Section A

a)Joint Photographic Elemental
Groups

b)Joint Picture Experts Groups

c)Joint Photographic Experts
Groups

d)Joint Photographic Experts
Graphics

1. What is the full form of JPEG of image format? [1]

a)Pixel b)Diploix image

c)Dots Per Inch d)Pixel image

2. DPI means: [1]

a)Bulling b)Phishing

c)Identity theft d)Stalking

3. In which of the following, a person is constantly followed/chased by another person
or group of several peoples?

[1]
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a)Adware b)Spyware

c)Malware d)Antivirus

4. Which of the following usually observe each activity on the internet of the victim,
gather all information in the background and send it to someone else?

[1]

a)It gets bonus point. b) It has to be activated
frequently.

c)New viruses are being created
daily.

d) In any case, we have to pay for
subscription.

5. Why should an antivirus be updated regularly? [1]

a)Ctrl + ( b)Ctrl + ]

c)Ctrl + [ d)Ctrl + )

6. Which of the following keys are pressed to increase the font size by 1 point? [1]

a)Spam b)Worm

c)Computer virus d)Application software

7. Which one of the following is not a malware? [1]

a)Reviewing Pane b)Show Markup

c)Track Changes d)Display for Review

8. ________ feature allows you to view different items such as comments, formatting
etc, and also provides the option to view other author's comments.

[1]

a)2 b)3

c)4 d)5

9. Into how many types, is the RAM further subdivided? [1]

a)EEPROM b)Both PROM abd EPROM

10. In which type of ROM, data can be erased by ultraviolet light and then
reprogrammed by the user or manufacturer?

[1]



Section B

c)EPROM d)PROM

a)Both A and R are true and R is
the correct explanation of A.

b)Both A and R are true but R is
not the correct explanation of
A.

c)A is true but R is false. d)A is false but R is true.

11. Assertion (A): The operating system supervises the overall operation of the
computer.
Reason (R): Booting is not an operation of an OS.

[1]

a)Both A and R are true and R is
the correct explanation of A.

b)Both A and R are true but R is
not the correct explanation of
A.

c)A is true but R is false. d)A is false but R is true.

12. Assertion (A): The document area is the place where the text is typed. The blinking
bar inside it is actually the insertion point and it represents the Location where text
will appear when typed.
Reason (R): Functions are ready-made design samples available in MS Word for
creating documents such as brochures, invitation cards, agendas and much more.

[1]

13. State at least two advantages of using a backup utility software. [2]

14. What is Count() function? [2]

OR

Discuss the steps involved in paragraph spacing in Word.

15. What do you understand by open-source software license? [2]

16. Define process scheduling. [2]

OR

Multimedia can Stimulate the eyes, ears, brain and fingertips of 4 person. With respect
to the given statement explain the meaning of multimedia.

17. What is disk defragmentation? [2]



Section C

Section D

Section E

18. Define free software licence. [2]

OR

Give three guidelines to prevent the virus attack.

19. What is a blog? [2]

20. What is MICR? Where is it mostly used? What are the major advantages and
disadvantages of MICR as general purpose input medium?

[3]

21. How to apply a shadow effect to WordArt? [3]

OR

Priyanka is working as marketing manager in an advertising company. She has prepared
a presentation on her latest product. What feature will be used for the following tasks?

i. To view all slides together.

ii. To set timings of the slide show while rehearsing.

iii. To show the sales using a chart.

22. How can you correct the mistakes done in worksheet? [3]

23. What is digital unite? Mention the measures to bridge the gap between digital
divide and digital unite.

[3]

24. What are the types of Cyber Crimes? [4]

OR

How can you use or browse internet safely?

25. Read the text carefully and answer the questions:

A word processor is software or a device that allows users to create, edit, and print
documents. It enables you to write text, store it electronically, display it on a screen,
modify it by entering commands and characters from the keyboard, and print it. The
editing and formatting capabilities of the word processor demonstrate the
application's true power. Text can be inserted, edited, moved, copied or deleted
within your document and the appearance of the text can be modified in numerous
ways. Most word processors also give you the ability to check your spelling and

[4]



grammar and many have built-in dictionaries and other tools to assist you in your
writing.

What is the default name for a Word document?(i)

What is the use of Save As of the File menu?(ii)

How to select a sentence in Word processor?(iii)

Define Font Face.(iv)

26. Read the text carefully and answer the questions:

Windows is a graphical operating system developed by Microsoft. It allows users to
view and store files, run software, play games, watch videos, and provides a way to
connect to the internet. It was released for both home computing and professional
works. Microsoft introduced the first version as 1.0. It was released for both home
computing and professional functions of Windows on 10 November 1983. Later, it
was released on many versions of Windows as well as the current version,
Windows 10. Microsoft Windows includes a wide array of features, tools, and
applications to help get the most out of Windows and your computer.

[4]

Define Drawing area.(i)

What is use of Calculator feature in window operating system?(ii)

Define WordPad.(iii)

What do you mean by the term sticky notes?(iv)



Section A
1. 

(c) Joint Photographic Experts Groups
Explanation:
Joint Photographic Experts Groups

2. 
(c) Dots Per Inch
Explanation:
Dots per inch is a measure of spatial printing, video or image scanner dot density, in
particular the number of individual dots that can be placed in a line within the span of 1
inch.

3. (a) Bulling
Explanation:
In general, Stalking refers to continuous surveillance on the target (or person) done by a
group of people or by the individual person.

4. 
(b) Spyware
Explanation:
It is generally defined as the software designed to enter the target's device or computer
system., gather all information, observe all user activities, and send this information to a
third party. Another important thing about the spyware is that it works in the background
sends all information without your permission.

5. 
(c) New viruses are being created daily.
Explanation:
New viruses are being created daily.

6. 
(b) Ctrl + ]
Explanation:
Ctrl + ]

7. 
(d) Application software
Explanation:
Application software

Solution
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8. 
(b) Show Markup
Explanation:
Show Markup feature under Review tab allows you to view different items.

9. (a) 2
Explanation:
2

10. 
(c) EPROM
Explanation:
EPROM

11. 
(c) A is true but R is false.
Explanation:
The operating system supervises the overall operation of the computer, including
monitoring the computer's status and scheduling operations, which include the input and
output processes. In addition, the operating system allocates CPU time and main memory
to programs running on the computer, and it also provides an interface between the user
and the hardware. Booting is one of the function of OS.

12. 
(c) A is true but R is false.
Explanation:
A is true but R is false.

Section B
13. i. Taking regular backups makes data reliable.

ii. Taking regular backups can make recovery easier during catastrophic disaster.
14. The Count() function counts how many cells contain a number instead of text.

OR
To change the paragraph spacing:
i. Click the Home tab. In the Paragraph group, click the Line Spacing command button. A

menu appears.
ii. Choose a new line spacing value. The line spacing is set for the current paragraph or all

selected paragraphs.
15. An opensource licence for computer software and other products allows the source code or

design to be used, modified and/or shared under defined terms and conditions.
16. The operating system allocates the processor (CPU) to a process and de-allocates

processor when a process is no longer required. The process management module of an



operating system takes care of the creation and deletion of the processes and scheduling of
various system resources to the different processes requesting them. This function is
known as process scheduling.

OR
Multimedia means any combination of text, audio, images, animation or video used for
communicating through messages or information.

17. Disk defragmentation is the process of optimising the storage space on the hard disk by
rearranging the fragments and storing files in contiguous disk locations.

18. A free software licence is a notice that grants the receiver of software wide-ranging rights
to use, modify or redistribute that particular software.

OR
Three guidelines to prevent the virus attack are as follows
i. Avoid the temptation to open unexpected e-mail attachments and downloads from

unreliable sources. Resist the urge to double-click everything in your mailbox.
ii. In stable reliable antivirus, scanning software and download its updates regularly.

iii. Scan files downloaded from the Internet or other external sources.
19. A website in which articles are posted regularly and displayed in reverse sequential order

is known as a Blog. Blog entries have the text, hypertext, images and links to the other
web pages, audio, videos, etc.

Section C
20. MICR stands for Magnetic Ink Character Recognition. It is a character recognition

technology that can read human unreadable characters that are printed using a special
magnetic ink. It is mostly used in banks to facilitate the processing of cheques. Advantages
of MICR are as follows
i. It decreases the margin of errors.

ii. Provides high security.
Disadvantages of MICR are as follows
i. Time consuming standards.

ii. The number of characters that can be recorded with present techniques is very limited.
21. Perform the below mentioned steps to apply a shadow effect to the WordArt.

Step 1: Select the WordArt text and Click on the Format tab.
Step 2: From the Text Effects drop-down list in the WordArt Styles group, choose the
Glow option. The Glow sublist will open.
Step 3: Select a glow style from the sublist.

OR
i. Press the Slide Sorter view button in workspace area to view all the slides together.



ii. In the Slide Transition page, set the timing in Advance slide sections automatically after
position where the slide will automatically play after a speculated time period.

iii. In the layouts of tasks pane, select a chart-type slide or use Insert  Chart menu option.
22. To Correct Mistakes done in worksheet, follow the given steps: If you make a mistake and

enter wrong data into a cell, there are three ways to correct it:
i. You can delete the content of cell (text, number of formula) by selecting it and then

press Delete key.
ii. You can type over what is already written there.

iii. You may double-dick in the cell and erase the character using backspace or delete key.
The two small buttons on the left of formula bar become active, as soon as you start
typing in a cell. The  button is the cancel button and it is used to cancel the data enter
without pressing the Delete key.
The  button if pressed, is equivalent to Enter button.

23. Digital unite refers to a society where everyone would be skilled and equipped to take
advantages of various ICT services. Everyone would be able to access the Internet, even in
rural and remote areas. People will be educated enough to utilise technology.
The gap between the digital divide and the digital unite must be covered, so that maximum
benefits can be taken from the technologies.
i. For making this possible, both the people and the governments should work together.

People should use such tools to educate themselves and not feel hesitant about learning
and using new technologies.

ii. Governments should work on providing basic education and basic infrastructure for
using such technologies to all the people so that maximum people can get the benefits
of technology.

Section D
24. When any crime is committed over the Internet it is referred to as a cybercrime. There are

many types of cyber crimes and the most common ones are explained below:
i. Hacking: This is a type of crime wherein a person's computer is broken into so that his

personal or sensitive information can be accessed. In hacking, the criminal uses a
variety of software to enter a person's computer and the person may not be aware that
his computer is being accessed from a remote location.

ii. Theft: This crime occurs when a person violates copyrights and downloads music,
movies, games and software.

iii. Cyberstalking: This is a kind of online harassment wherein the victim is subjected to a
barrage of online messages and emails. Typically, these stalkers know their victims and
instead of resorting to offline stalking, they use the Internet to stalk.

→

×

×



iv. Identity theft: This has become a major problem with people using the Internet for
cash transactions and banking services. In this cybercrime, a criminal accesses data
about a person's bank account, credit cards, social security, debit card and other
sensitive information to siphon money or to buy things online in the victim's name. It
can result in major financial losses for the victim and even spoil the victim's credit
history.

v. Malicious Software: These are Internet-based software or programs that are used to
disrupt a network. The software is used to gain access to a system to steal sensitive
information or data or causing damage to software present in the system.

OR
Internet is the network of networks. Now-a-days it is the basic need of maximum people.
There are some steal which can be followed while using Internet for the safety purpose.
i. We can install and use most secure internet browser like (Google Chrome and Mozilla

Firefox).
ii. We can customise our security settings like (shutting off features like "auto-fill", turning

off "cookies", block pop-up windows) so that nobody can access our data.
iii. We can create typical password which cannot be recognized by others.
iv. We can hide your IP (Internet Protocol) with a VPN (Virtual Private Network).
v. We should download software from trusted sources.

vi. We should use latest Anti-Virus protection for computer and data safety.
vii. We should be prompt about updating your operating system and software.

viii. We should use secure WiFi.
We should keep backup of our data.

Section E
25. Read the text carefully and answer the questions:

A word processor is software or a device that allows users to create, edit, and print
documents. It enables you to write text, store it electronically, display it on a screen,
modify it by entering commands and characters from the keyboard, and print it. The
editing and formatting capabilities of the word processor demonstrate the application's true
power. Text can be inserted, edited, moved, copied or deleted within your document and
the appearance of the text can be modified in numerous ways. Most word processors also
give you the ability to check your spelling and grammar and many have built-in
dictionaries and other tools to assist you in your writing.

Document! is the default name for a Word document.(i)
The Save As of the File menu allows you to make a copy of the current document.(ii)
Hold down the Ctrl key and click anywhere on the sentence. This will select that
sentence.

(iii)



26. Read the text carefully and answer the questions:
Windows is a graphical operating system developed by Microsoft. It allows users to view
and store files, run software, play games, watch videos, and provides a way to connect to
the internet. It was released for both home computing and professional works. Microsoft
introduced the first version as 1.0. It was released for both home computing and
professional functions of Windows on 10 November 1983. Later, it was released on many
versions of Windows as well as the current version, Windows 10. Microsoft Windows
includes a wide array of features, tools, and applications to help get the most out of
Windows and your computer.

Font Face is a set of characters, including letters, numbers, symbols and punctuators.(iv)

Drawing area is the area where you create your drawings using different tools of Paint.(i)
The Calculator is a utility program that allows you to do mathematical and scientific
calculations. It works like a regular calculator.

(ii)

WordPad is a small word processor program that is used to type the documents. It has
features to let you type the text as well as to format the text.

(iii)

Sticky notes is another useful feature of Windows 7 and it can be placed on the desktop.
These are used for writing reminders or for making a To Do List.

(iv)
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